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license and may be used or copied only in 
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Restricted Rights Legend
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a U.S. Government prime contract or sub-
contract, Software is delivered and 
licensed as “Commercial computer soft-
ware” as defined in DFAR 252.227-7014 
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Rights as defined in FAR 52.227-14 
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Safety Notices

 A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met.

A CAUTION notice calls attention to an 
operating procedure, practice, or the like 
that, if not correctly performed or adhered 
to, could result in damage to the product or 
loss of important data. Do not proceed 
beyond a CAUTION notice until the indi-
cated conditions are fully understood and 
met.
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Preface
About this guide
About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

Installers, integrations, lab managers, and administrators are users who must 
have technical expertise. In addition, lab managers and administrators are 
individuals or groups responsible for the use and maintenance of the Labware 
MiniHub and for ensuring that operators are adequately trained.

What this guide covers

This guide describes the Labware MiniHub, the operation of the hardware 
components, and the use of the diagnostics software.

This guide does not provide instructions for the following:

• VWorks software or third- party software

• Agilent Technologies products, such as the BenchCel Workstation and the 
BioCel System

• Third- party devices

For more information about these topics, see the relevant user guides for these 
products.

Software version

This guide documents Labware MiniHub Diagnostics version 1.0.1 or later.
                                                        

Job role Responsibilities

Installer Unpacks, installs, and tests the Labware MiniHub before it 
is used.

Integrator Writes software and configures hardware.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
Labware MiniHub

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the Labware 
MiniHub and solves routine problems.
vi Labware MiniHub User Guide
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Related guides

The Labware MiniHub User Guide should be used in conjunction with the 
following documents (if applicable):

• Labware MiniHub Unpacking Guide. Explains how to unpack the Labware 
MiniHub in preparation for installation. In addition, packing instructions 
are provide in case the Labware MiniHub will be moved or kept in storage.

• Labware MiniHub Safety and Installation Guide. Presents the safety 
precautions, emergency stop procedure, site preparation information, and 
installation instructions.

• Automation system or workstation user guide. Explains how to set up the 
system or workstation and set teachpoints at integrated devices. If you are 
using the BioCel System, see the BioCel System User Guide. If you are 
using the BenchCel Workstation, see the BenchCel Microplate Handling 
Workstation User Guide.

• Automation system software user guide. Explains how to create and run 
protocols. If you are using the VWorks software, see the VWorks 
Automation Control Setup Guide and VWorks Automation Control User 
Guide.

Related information

                                                        

For information about... See...

Accessing related user guides “Accessing Automation Solutions user 
guides” on page viii

Reporting problems “Reporting problems” on page 68
viiLabware MiniHub User Guide
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Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation. 

Accessing safety information

Safety information for the Agilent Technologies devices appears in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.
viii Labware MiniHub User Guide
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
ixLabware MiniHub User Guide
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Features in the Knowledge Base window

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
x Labware MiniHub User Guide
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Related information

For information about... See...

Who should read this guide “About this guide” on page vi

What this guide covers “About this guide” on page vi

Reporting problems “Reporting problems” on page 68
xiLabware MiniHub User Guide
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Labware MiniHub
User Guide
1
Introduction

This chapter contains the following topics:

• “About the Labware MiniHub” on page 2

• “Before you operate the Labware MiniHub” on page 4

• “Hardware overview” on page 5

• “Software overview” on page 9

• “Quick start” on page 12
1
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1   Introduction
About the Labware MiniHub
About the Labware MiniHub

Description

The Labware MiniHub is a rotating random- access labware storage device. Up 
to four labware can be placed on each shelf in either the landscape or portrait 
orientation. Spacing blocks, also called spacers, can be added or removed to 
adjust the distance between shelves, accommodating different labware types 
(microplates, tip boxes, or tube racks).

The following models of the Labware MiniHub are available:

Model Description

G5471A Designed to be integrated in large laboratory 
automation systems such as the BioCel System.

The model permits the following basic 
configurations:

• 16 shelves, with single spacers between 
shelves, accommodate a maximum of 
64 microplates

• 9 shelves, with two spacers between 
shelves, accommodate a maximum of 
36 deepwell microplates or tube racks

• 6 shelves, with three spacers between 
shelves, accommodate a maximum of 24 tip 
boxes

Other configurations can be created using 
different combinations of shelves and spacers.

G5489A Designed to be integrated in workstations or 
systems that have the BenchBot Robot.

The model permits the following basic 
configurations:

• 13 shelves, with single spacers between 
shelves, accommodate a maximum of 
52 microplates

• 7 shelves, with two spacers between 
shelves, accommodate a maximum of 
28 deepwell microplates or tube racks

• 5 shelves, with three spacers between 
shelves, accommodate a maximum of 20 tip 
boxes

Other configurations can be created using 
different combinations of shelves and spacers.
2 Labware MiniHub User Guide
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About the Labware MiniHub
Related information

G5472A Designed to be integrated in the BenchCel 
Workstation.

The model permits the following basic 
configurations:

• 10 shelves, with single spacers between 
shelves, accommodate a maximum of 
40 microplates

• 5 shelves, with two spacers between 
shelves, accommodate a maximum of 
20 deepwell microplates or tube racks

• 3 shelves, with three spacers between 
shelves, accommodate a maximum of 12 tip 
boxes

Other configurations can be created using 
different combinations of shelves and spacers.

Model Description

For information about... See...

Labware MiniHub safety Labware MiniHub Safety and 
Installation Guide

Preparing the lab for the Labware 
MiniHub installation

Labware MiniHub Safety and 
Installation Guide

Installing the Labware MiniHub Labware MiniHub Safety and 
Installation Guide

Hardware components “Hardware overview” on page 5

Software overview “Software overview” on page 9
3Labware MiniHub User Guide



1   Introduction
Before you operate the Labware MiniHub
Before you operate the Labware MiniHub

Related information

WARNING  For safe operation, it is imperative that you follow the precautions in 
Labware MiniHub Safety and Installation Guide.

For information about... See...

Safety precautions Labware MiniHub Safety and 
Installation Guide

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Hardware components “Hardware overview” on page 5

Software overview “Software overview” on page 9
4 Labware MiniHub User Guide



1   Introduction
Hardware overview
Hardware overview

About this topic

This topic describes the following Labware MiniHub features:

• Main components

• Power supply

• Indicator lights

Main components

The following diagram shows the main components of the Labware MiniHub:

1

2

4

3

5

6

Item Name Description

1 Base Gray structure at the bottom of the MiniHub that 
attaches the MiniHub to the target surface. The base 
contains some electronics and hosts the indicator 
lights.

2 Shelves Flat area on which you can place labware. Locating 
pins at the edges of the shelves hold the labware 
securely in place.
5Labware MiniHub User Guide
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Hardware overview
Power supply

The power supply is the component that supplies electrical power to the 
Labware MiniHub and is the communication connection between the Labware 
MiniHub and the controlling computer.

Front

3 Spacers Metal spacing blocks that you can add or remove at the 
center of the hub.

Two types of spacers are available:

• 25.1- mm spacers. Stacked between shelves to 
accommodate different labware heights.

• 8.4- mm spacers. Stacked above the top- most shelf 
to fill the space between the top- most 25.1- mm 
spacer and the cassette cap. These spacers ensure 
a tight assembly and are only necessary when a 
subset of the shelves are used.

4 Cassette cap Metal label with numerical identification of each 
cassette. The numbers are used in Labware MiniHub 
Diagnostics and in VWorks software.

5 Cassettes Columns of shelves. The MiniHub consists of four 
cassettes, each identified by the number on the 
cassette cap. 

6 Black knob Component at the top of the MiniHub that locks the 
spacers and shelves in places.

Item Name Description

24VDC Power Supply

1

Item Name Description

1 Power switch To turn on the power, press the on ( I ) end 
of the switch. To turn off the power, press 
the off ( O ) end of the switch.
6 Labware MiniHub User Guide
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Hardware overview
Back

 

Indicator lights

At the base of the Labware MiniHub are two indicator lights. One light 
indicates power status, the other light indicates error conditions.

100 - 240 V~
4 A
50/60 Hz

T 4 A 250 V

24 V 24 V

2

31

Item Name Description

1 Power inlet and fuse 
housing

Connects the power supply unit to the power 
source. Use only the supplied power cord.

The small compartment immediately below 
the inlet contains two fuses for power inlet.

2 Fuse housings Holds fuses for power outlet.

3 Labware MiniHub 
cable connector

Connects the Labware MiniHub to the power 
supply unit. Use only the supplied Labware 
MiniHub cable.

POWER
ERROR
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Related information

Name Description

Power Indicates whether the power is on or off. When the 
green light is on, the power is on. When the green 
light is off, the power is off.

Error Indicates whether an error is encountered. When the 
red light flashes, an error has occurred. When the 
red light is off, the Labware MiniHub is operating 
normally.

For information about... See...

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Labware MiniHub safety “Before you operate the Labware 
MiniHub” on page 4

Software overview “Software overview” on page 9
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Software overview

About this topic

This topic describes the software components you use to operate the Labware 
MiniHub:

• Labware MiniHub Diagnostics

• Laboratory automation software

Labware MiniHub Diagnostics

The Labware MiniHub Diagnostics software allows you to:

• Create and manage profiles. A profile allows you to set up communication 
between the Labware MiniHub and the controlling computer, configure the 
Labware MiniHub (tell the software the number of shelves you are using), 
and set the rotation speed. For instructions, see “Creating Labware 
MiniHub profiles” on page 30.

• Set the home position. The home position is the starting position of the 
Labware MiniHub relative to the robot in the laboratory automation system 
or BenchCel Workstation. For instructions, see “Setting the home position” 
on page 34.

• Diagnose problems. Moving and adjusting the Labware MiniHub allow you 
to diagnose and troubleshoot problems. For information on diagnosing and 
troubleshooting problems, see “Using Labware MiniHub Diagnostics” on 
page 41 and “Troubleshooting” on page 61.

Access to Labware MiniHub Diagnostics depends on the automation software 
you are using. For more information, see “Using Labware MiniHub Diagnostics” 
on page 41.
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Laboratory automation software

You can use either the VWorks software or third-party automation software to 
operate the MiniHub in protocol runs. If you plan to use third-party 
automation software, you will need to use the MiniHub ActiveX control to 
permit the software to interface with the hub.

VWorks software
The VWorks software allows you to:

• Set up the Labware MiniHub. During setup, you need to create a device 
file for the Labware MiniHub. For setup information, see “Setting up the 
Labware MiniHub” on page 15.

• Set up user accounts and privileges. You can set up different user 
accounts to enforce access policies. For instructions, see the VWorks 
Automation Control Setup Guide.

• Define labware. Labware definitions describe the labware you will use 
during protocol runs. For instructions, see the VWorks Automation Control 
Setup Guide.

• Create protocols. Protocols determine the sequence of tasks you want to 
automate in a run. For example, you can use a protocol to unload 
60 microplates from the Labware MiniHub, apply barcode labels to the 
microplates, and then reload the microplates to the hub. For protocol-
writing instructions, see the VWorks Automation Control User Guide.

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, 
and stop a protocol run from the controlling computer. For instructions, 
see the VWorks Automation Control User Guide.

For a full description and instructions on how to use the VWorks software, see 
the VWorks Automation Control User Guide.
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MiniHub ActiveX control
Instead of using the VWorks software, you can use another automation control 
software to operate the Labware MiniHub in protocol runs. The MiniHub 
ActiveX control allows the automation software to interface with the device. 
For more information, see “MiniHub ActiveX control” on page 77.

Related information

For information about... See...

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Labware MiniHub safety “Before you operate the Labware 
MiniHub” on page 4

Hardware components “Hardware overview” on page 5

MiniHub ActiveX control “MiniHub ActiveX control” on page 77
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Quick start

Overall setup workflow

The following table presents the basic steps for setting up the Labware 
MiniHub for operation.

Step For this task... See...

1 Prepare the lab for the 
Labware MiniHub installation.

Labware MiniHub Safety and 
Installation Guide

2 Unpack the Labware MiniHub. Labware MiniHub Safety and 
Installation Guide

3 Install the Labware MiniHub. Labware MiniHub Safety and 
Installation Guide

4 Turn on the Labware MiniHub. “Turning on and turning off the 
Labware MiniHub” on page 17

5 Install the VWorks software, or 
integrate the MiniHub ActiveX 
control.

One of the following:

• VWorks Automation Control 
Setup Guide

• “MiniHub ActiveX control” on 
page 77

6 VWorks software only. Start 
the VWorks software and log 
in.

VWorks Automation Control User 
Guide

7 VWorks software only. Create 
a new device file (if not 
already done).

“Creating a device file” on page 19

8 VWorks software only. Add 
the Labware MiniHub in the 
device file.

“Adding and deleting a Labware 
MiniHub in the device file” on 
page 21

9 Create a Labware MiniHub 
profile and set the profile 
parameters.

“Creating Labware MiniHub 
profiles” on page 30

10 Set the MiniHub home 
position.

“Setting the home position” on 
page 34

11 Set robot teachpoints. Both of the following:

• “Setting robot teachpoints” on 
page 39

• Automation system or robot 
user documentation

12 VWorks software only. Set the 
Labware MiniHub device 
properties.

“Setting Labware MiniHub 
properties” on page 23
12 Labware MiniHub User Guide
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13 BenchCel Workstation only. 
Select the stack- holding 
method in the Labware Editor.

“Selecting the stack- holding 
method” on page 26

14 Write and run protocols. One of the following:

• VWorks Automation Control 
User Guide

• Automation software user 
documentation

Step For this task... See...

For information about... See...

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Labware MiniHub safety “Before you operate the Labware 
MiniHub” on page 4

Hardware components “Hardware overview” on page 5
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Setting up the Labware MiniHub

This chapter explains how to set up the Labware MiniHub in the 
VWorks software. This chapter contains the following topics:

• “Setup workflow” on page 16

• “Turning on and turning off the Labware MiniHub” on page 17

• “Creating a device file” on page 19

• “Adding and deleting a Labware MiniHub in the device file” on 
page 21

• “Setting Labware MiniHub properties” on page 23

• “Selecting the stack- holding method” on page 26

If you are using a different lab automation software and want to 
integrate the Labware MiniHub using ActiveX control, see “MiniHub 
ActiveX control” on page 77.
15
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Setup workflow

About this topic

This topic presents the workflow for turning on the Labware MiniHub at the 
power supply and setting it up in the VWorks software.

Workflow

The following table presents the steps for setting up the Labware MiniHub in 
the VWorks software. After setting up the Labware MiniHub for the first time, 
you will not likely need to change any of the settings in the procedure.

Step For this task... See...

1 Turn on the Labware MiniHub. “Turning on and turning off the 
Labware MiniHub” on page 17

2 Start the VWorks software and 
log in.

VWorks Automation Control User 
Guide

3 Create a device file. “Creating a device file” on page 19

4 Add the Labware MiniHub in 
the device file.

“Adding and deleting a Labware 
MiniHub in the device file” on 
page 21.

5 Set the Labware MiniHub 
properties in VWorks software.

“Setting Labware MiniHub 
properties” on page 23

6 BenchCel model only. Select 
the stack- holding method in 
the Labware Editor.

“Selecting the stack- holding 
method” on page 26
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Turning on and turning off the Labware MiniHub

Turning on the Labware MiniHub

To turn on the Labware MiniHub:

At the front of the Labware MiniHub power supply, press the on/off switch to 
the on ( I ) position. The on/off switch light turns on. The Labware MiniHub 
rotates slowly to its factory- set home position.

Turning off the Labware MiniHub

To turn on the Labware MiniHub:

At the front of the Labware MiniHub power supply, press the on/off switch to 
the off ( O ) position. The on/off switch light turns off.

 

Related information

CAUTION The Labware MiniHub will rotate during the startup process. Obstructing the 
Labware MiniHub while it is rotating will cause an error.

24VDC Power Supply

24VDC Power Supply

For information about... See...

Safety information Labware MiniHub Safety and 
Installation Guide

Adding the Labware MiniHub in 
the device file

“Adding and deleting a Labware 
MiniHub in the device file” on page 21

Creating profiles for the Labware 
MiniHub

“Creating Labware MiniHub profiles” on 
page 30
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Turning on and turning off the Labware MiniHub
Specifying the stack- holding 
method

“Selecting the stack- holding method” on 
page 26

Setting teachpoints “Setting robot teachpoints” on page 39

For information about... See...
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Creating a device file

About this topic

This topic explains how to create a device file in the VWorks software. If you 
have an existing automation system or a BenchCel Workstation, and you 
already have a device file you want to use, skip this step and proceed to 
“Adding and deleting a Labware MiniHub in the device file” on page 21.

Devices and device file defined

What is a device?
A device is an item in your lab automation system that has an entry in the 
VWorks software device file. A device can be a robot, an instrument, or a 
location in the system that can hold a piece of labware. The following are some 
examples of devices:

• Automation system robot, such as the Direct Drive Robot

• BenchCel robot

• Labware MiniHub

• PlateLoc Thermal Microplate Sealer

• Microplate Labeler

• Vertical Pipetting Station

• Platepad

• All third- party devices integrated in the lab automation system

What is a device file?
To communicate with and to control the robot and integrated devices, the 
VWorks software uses a device file that contains the following information:

• List of devices the software will communicate with and control

• Profile of each device (communication method, unique device configuration 
information)

• System- related configuration information of each device (for example, 
approach height, barcode access, and so on)

You provide the device information in the VWorks software. The device 
information is stored in a device (.dev) file that is located in a folder you 
specify when saving the file.

For detailed information about device files and associations with profiles, 
teachpoint files, and other VWorks components, see the VWorks Automation 
Control User Guide.

Procedure

If you are setting up a lab automation system such as the BioCel System or 
the BenchCel Workstation for the first time, you need to create a new device 
file, and then add the system or workstation robot, the Labware MiniHub, and 
integrated devices to this file.

Before you create a device file, start the VWorks software and log in. See the 
VWorks Automation Control User Guide for instructions.
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To create a new device file:

1 In the VWorks window, select File > New > Device. A Device File tab appears.

2 Select File > Save to save the device file. The file name appears in the 
Device File tab.

Related information

For information about... See...

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

Adding the Labware MiniHub in 
the device file

“Adding and deleting a Labware 
MiniHub in the device file” on page 21

Creating profiles for the Labware 
MiniHub

“Creating Labware MiniHub profiles” on 
page 30

Specifying the stack- holding 
method

“Selecting the stack- holding method” on 
page 26

Setting teachpoints “Setting robot teachpoints” on page 39
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Adding and deleting a Labware MiniHub in the device file 

Adding a Labware MiniHub in the device file

To add a Labware MiniHub in the device file:

1 In the Available Devices area, double- click the Labware MiniHub device icon. 
Alternatively, you can drag the icon from the Available Devices area into the 
Device File area.

Notice that in the Devices area, the first Labware MiniHub device is labeled 
Labware MiniHub- 1. If you add another Labware MiniHub device, it will 
appear as Labware MiniHub- 2.

If you do not see the Labware MiniHub in the Available Devices list, check 
that the MiniHub plugin file (AgilentLabwareMiniHub.dll) is stored in the 
following folder: ...\Agilent Technologies\VWorks\Plugins.

If you added the Labware MiniHub plugin file in the Plugins folder and you 
have already started the VWorks software, be sure to reload the plugin. To 
do this, close any open device files and protocol files, and then select 
Tools > Reload Plugins.

2 If you have multiple Labware MiniHub devices in the system, repeat step 1 
to add the other Labware MiniHub devices.
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Deleting a Labware MiniHub from the device file

To delete a Labware MiniHub from the device file:

1 In the VWorks window, select the Labware MiniHub you want to delete in 
the Devices area.

2 Click Delete selected devices.

Related information

For information about... See...

Creating profiles for the Labware 
MiniHub

“Creating Labware MiniHub profiles” on 
page 30

Editing profiles “Editing and managing profiles” on 
page 33

Setting up Labware MiniHub 
properties in the device file

“Setting Labware MiniHub properties” 
on page 23

Specifying the stack- holding 
method

“Selecting the stack- holding method” on 
page 26

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide
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Setting Labware MiniHub properties 

About the Labware MiniHub properties

In the device file, you can set properties for each device. For the Labware 
MiniHub, you can name the Labware MiniHub, select the desired profile, and 
associate the robot teachpoint with each shelf.

The instructions in this topic assumes that you have already:

• Created a Labware MiniHub profile.

• Set the Labware MiniHub home position.

• Set the robot teachpoints for each shelf.

Procedure

To set the Labware MiniHub properties:

1 In the Labware MiniHub Properties area of the device file, type or select the 
following:

Adding the automation system or 
workstation robot and creating 
profiles for the robot

• Automation system user 
documentation, such as the BioCel 
System User Guide

• BenchCel Microplate Handling 
Workstation User Guide

For information about... See...
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2 In the Devices area, expand Labware MiniHub, and then select Slot 1.

3 In the Labware MiniHub Location Properties area, set the following parameters:

Property Description

Name The name of the Labware MiniHub.

Type a name for the Labware MiniHub. In the 
following example, the name for the Labware 
MiniHub is My MiniHub.

Profile The profile associated with the device.

Select the desired profile from the list. If the profile 
you want does not appear in the list, or if no 
profile appears in the list, see “Creating Labware 
MiniHub profiles” on page 30, and then return to 
this step to select the profile.

IMPORTANT Without the profile, you will not be 
able to establish communication with the device.

Parameter Description

Allow/prohibited labware Permitted labware class for the selected 
location.

For example, you might specify that 
only tip boxes are allowed at a given 
location. For details on labware classes, 
see the VWorks Automation Control 
Setup Guide.

BCR on south/west/north/east 
side

The location of the barcode reader and 
the desired barcode reader device.

Use this field only if a barcode reader 
is installed on the device.
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4 Repeat steps 2 and 3 to set the properties for the remaining slots.

5 Select File > Save to save the device file.

6 In the Device File area, select the Labware MiniHub, and then click Initialize 
selected devices to establish communication with the device.

Related information

Teachpoint for robot 
<robot_name>

The name of the teachpoint at the 
selected Slot location. This selection 
enables the robot to move correctly to 
and from the Slot location during a 
protocol run.

If the robot teachpoint file contains a 
teachpoint for this slot, you must select 
that teachpoint.

Note: In simulation mode, select 
<accessible>.

Use for deadlock avoidance The option to permit the location to be 
used for deadlock avoidance.

Select Yes to permit labware to be 
moved to this location to avoid a 
deadlock in the system.

Select No if you do not want to move 
random labware to this location to 
avoid deadlock.

IMPORTANT For typical operation, 
select No for the Labware MiniHub.

Door Not applicable

Parameter Description

For information about... See...

Creating profiles for the Labware 
MiniHub

“Creating Labware MiniHub profiles” on 
page 30

Editing profiles “Editing and managing profiles” on 
page 33

Specifying the stack- holding 
method

“Selecting the stack- holding method” on 
page 26

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

Adding the automation system or 
workstation robot and creating 
profiles for the robot

• Automation system user 
documentation, such as the BioCel 
System User Guide

• BenchCel Microplate Handling 
Workstation User Guide
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Selecting the stack-holding method

About this topic

This topic explains how to select the stack- holding method in the VWorks 
Labware Editor. The instructions are applicable to Labware MiniHubs 
integrated in BenchCel Workstations only.

Procedure

For precision performance, use the BenchCel stacker grippers to hold the 
labware in the stacks.

To select the stack holding method:

1 In the VWorks software, select Tools > Labware Editor.

2 In the Labware Editor, select the labware from the list on the left.

3 Click the BenchCel tab.

4 In the Stack holding method list, select Hold with stacker grippers.

5 Click Save changes.
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Related information

For information about... See...

Labware Editor BenchCel tab 
parameters and settings

VWorks Automation Control Setup 
Guide

Labware specifications “Labware and shelf pitch specifications” 
on page 32

Creating profiles “Creating Labware MiniHub profiles” on 
page 30

Editing and managing profiles “Editing and managing profiles” on 
page 33

Setting the home position “Setting the home position” on page 34

Configuring the Labware MiniHub “Configuration workflow” on page 30
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Configuring the Labware MiniHub

This chapter contains the following topics:

• “Configuration workflow” on page 30

• “Creating Labware MiniHub profiles” on page 30

• “Editing and managing profiles” on page 33

• “Setting the home position” on page 34

• “Setting robot teachpoints” on page 39
29
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Configuration workflow

About this topic

This topic presents the workflow for configuring the Labware MiniHub in 
Labware MiniHub Diagnostics. You will need to perform this step whether you 
are using the VWorks software or a different automation control software with 
the MiniHub ActiveX control.

Workflow

The following table presents the steps for setting up the Labware MiniHub in 
the Labware MiniHub Diagnostics.

Creating Labware MiniHub profiles 

About profiles

A VWorks device profile is a collection of settings, stored in the Windows 
registry, that manages how you connect to a device. A Labware MiniHub 
profile specifies the following:

• COM port used to establish communication between the device and the 
controlling computer.

• Number of shelves (or slots) in each Labware MiniHub cassette.

You use the MiniHub Diagnostics software to create and manage Labware 
MiniHub profiles.

Note: If you are using the VWorks software, be aware that each device in the 
device file requires a unique profile. For information about device files, see 
“Creating a device file” on page 19. For a detailed description of the 
relationships between the device file and profile, see the VWorks Automation 
Control User Guide.

Step For this task... See...

1 Create a profile for the 
Labware MiniHub.

“Creating Labware MiniHub 
profiles” on page 30

2 Edit or rename the profile. “Editing and managing profiles” on 
page 33

3 Set the Labware MiniHub 
home position.

“Setting the home position” on 
page 34

4 Set robot teachpoints. “Setting robot teachpoints” on 
page 39
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Creating a Labware MiniHub profile 

To create a Labware MiniHub profile:

1 Use one of the following methods to open Labware MiniHub Diagnostics:

• In the VWorks software Devices area, select the Labware MiniHub name, 
and then click Device diagnostics.

• If you are using a different automation software, call the 
ShowDiagsDialog method to open Labware MiniHub Diagnostics. For 
details, see “MiniHub ActiveX control” on page 77.

The Labware MiniHub Diagnostics dialog box opens.
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2 If it is not already displayed, click the Profiles tab.

3 In the Profile Management area, click Create a new profile. The Create Profile 
dialog box opens.

4 Type a name, and click OK. The name appears in the Profile Management 
area.

5 In the Profile Settings area, set the following parameters:

6 Click Update this profile to save the changes.

7 Click Initialize this profile to establish communication with the Labware 
MiniHub.

Related information

Profile parameter Description

Serial Port The controlling computer COM port that is 
connected to the Labware MiniHub.

Slots Per Cassette The number of shelves in each cassette. (A 
cassette is a column of shelves. The Labware 
MiniHub consists of four cassettes.)

The maximum number of slots possible 
depends on the Labware MiniHub model:

• The system model has a maximum of 
16 slots.

• The BenchBot model has a maximum of 
13 slots.

• The BenchCel model has a maximum of 
10 slots.

Speed The speed at which the Labware MiniHub 
rotates during protocol runs. The three 
selections are:

• Slow. Turns the MiniHub at 25% of the 
factory- set maximum speed.

• Medium. Turns the MiniHub at 50% of 
the factory- set maximum speed.

• Fast. Turns the MiniHub at 100% of the 
factory- set maximum speed.

CAUTION The Labware MiniHub will rotate during the initialization process. 
Obstructing the Labware MiniHub while it is rotating will cause an error.

For information about... See...

Editing and managing profiles “Editing and managing profiles” on 
page 33

Setting the home position “Setting the home position” on page 34

Setting robot teachpoints “Setting robot teachpoints” on page 39

Configuring the Labware MiniHub “Configuration workflow” on page 30
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Editing and managing profiles

Editing profiles

To edit a profile:

1 In the Labware MiniHub Diagnostics Profiles tab, select the profile you want 
to edit in the Profile Management area.

2 Modify the profile information.

Note: Changes you make in the profile are shown in the table below the 
Profile Settings area. In addition, the changes are shown in the log area 
at the bottom of the dialog box.

3 When you are finished, click Update this profile to save the changes.

Managing profiles

In the Labware MiniHub Diagnostics Profiles tab, you can select an existing 
profile, and then rename, copy, or delete the profile.

Related information

CAUTION A copy of an existing profile references the same home position. 

For information about... See...

Creating profiles “Creating Labware MiniHub profiles” on 
page 30

Setting the home position “Setting the home position” on page 34

Setting robot teachpoints “Setting robot teachpoints” on page 39

Configuring the Labware MiniHub “Configuration workflow” on page 30
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Setting the home position

About the home position

The Labware MiniHub home position is the position at which the automation 
system robot accesses any slot in cassette 1. Cassette 1 is identified by the 
number 1 on the cassette cap.

When the MiniHub is in the home position, the Position value in the Controls 
tab is set at 0.
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Before you start

Make sure you:

• Have a teaching jig or standard microplate you want to use for the 
procedure.

• System model. Use the robot to pick up the teaching jig or microplate from 
a platepad. The robot should be holding the teaching jig or microplate.

• BenchCel model. Load the labware you want to use in one of the stackers, 
and then downstack a labware. The robot should be holding the labware.

Procedure

To set the Labware MiniHub home position:

1 Disable the automation system or BenchCel robot so that you can manually 
move the robot arm. For instructions, see the automation system robot user 
guide or the BenchCel Microplate Handling Workstation User Guide.

2 In Labware MiniHub Diagnostics, click the Controls tab, and then click Disable 
in the Motor area. You should be able to manually rotate the hub.
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3 Manually rotate the MiniHub so that cassette 1 faces the robot. This is the 
approximate home position.

The following diagram shows the top view of the automation system robot 
and the hub. Notice that cassette 1 is facing the robot.

The following diagram shows the top view of the BenchCel Workstation and 
the hub. Notice that cassette 1 is facing the BenchCel robot.

4 Move the robot so that the microplate sits in shelf 1, the bottom- most 
shelf, in cassette 1.

Note: You can place the microplate in any cassette- 1 shelf. However, 
because you will need to set a robot teachpoint at each shelf later, it is 
convenient to start with shelf 1 in this procedure.
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5 Check the position of the microplate. You might have to rotate the MiniHub 
slightly or move the robot arm until the microplate is seated correctly in 
the slot.

If the microplate is seated at a slight angle to the shelf, rotate the MiniHub 
slightly to adjust the microplate position.

BenchCel model. If the microplate is sitting too far forward (as shown) or 
backward, and adjusting the robot and MiniHub manually do not solve the 
problem, unlock the Labware MiniHub integration plate. Move the hub-
integration plate assembly forward or backward until the microplate is 
seated correctly in the slot.

6 In the Labware MiniHub Diagnostics Controls tab, click Teach Home. Notice that 
the Position value is set at 0.
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7 In the Profiles tab, click Update this profile to save the change.

8 Leave the labware and robot in their current position and proceed to set 
the robot teachpoints.

Related information

For information about... See...

Creating profiles “Creating Labware MiniHub profiles” on 
page 30

Editing and managing profiles “Editing and managing profiles” on 
page 33

Setting robot teachpoints “Setting robot teachpoints” on page 39

Configuring the Labware MiniHub “Configuration workflow” on page 30
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Setting robot teachpoints

About setting robot teachpoints

After setting the Labware MiniHub home position, you must set robot 
teachpoints at each shelf in cassette 1. To set, edit, and verify robot 
teachpoints, see the automation system robot user documentation or the 
BenchCel Microplate Handling Workstation User Guide.

Note: You only need to set teachpoints at all of the shelves in cassette 1. The 
software will reference these teachpoints when accessing shelves in cassettes 2, 
3, and 4.

IMPORTANT Before setting the robot teachpoints, make sure the hub’s motor 
is enabled. For instructions, see “Enabling and disabling the motor” on 
page 46. In addition, make sure the MiniHub is at its home position. For 
instructions, see “Rotating the MiniHub to a specific position” on page 49.

If you used shelf 1 to set the home position, you can go ahead and set the 
robot teachpoint at shelf 1 while you have the robot and microplate in 
position.

About the approach height

IMPORTANT For each teachpoint, set the approach height such that it is 
greater than the height of the locating pins on the MiniHub shelf and less than 
the shelf directly above. For example, the locating pins are 5.1 mm tall, so the 
minimum approach height should be 6 mm if single spacers are used between 
shelves.

Figure Approach height considerations at each shelf.

About verifying teachpoints

You must verify robot teachpoints after setting them. For instructions, see the 
automation system robot user documentation or the BenchCel Microplate 
Handling Workstation User Guide.
                                                        

6 mm
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Related information

For information about... See...

Labware specifications Labware MiniHub Safety and 
Installation Guide

Creating profiles “Creating Labware MiniHub profiles” on 
page 30

Editing and managing profiles “Editing and managing profiles” on 
page 33

Setting the home position “Setting the home position” on page 34

Configuring the Labware MiniHub “Configuration workflow” on page 30
40 Labware MiniHub User Guide



Labware MiniHub
User Guide
4
Using Labware MiniHub Diagnostics

This chapter explains how to use the provided software tools to 
diagnose and troubleshoot the Labware MiniHub.

This chapter contains the following topics:

• “About Labware MiniHub Diagnostics” on page 42

• “Checking the MiniHub’s current position” on page 44

• “Enabling and disabling the motor” on page 46

• “Changing the rotation speed” on page 47

• “Rotating the MiniHub to a specific position” on page 49

• “Checking the error indicator” on page 52

• “Viewing the log area” on page 53
41
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About Labware MiniHub Diagnostics
About Labware MiniHub Diagnostics 

Labware MiniHub Diagnostics Controls tab

The Labware MiniHub Diagnostics software allows you to create profiles and 
control the motions of the Labware MiniHub. The software has two tabs: 
Controls and Profiles. You mainly use the commands and parameters available 
in the Controls tab to troubleshoot problems.

Opening Labware MiniHub Diagnostics

Access to Labware MiniHub Diagnostics depends on the automation software 
you are using: VWorks software or third- party automation software.

VWorks software
In the VWorks software Devices area, select the Labware MiniHub name, and 
then click Device diagnostics.
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Third-party automation software
If you are using a different automation software, call the ShowDiagsDialog 
method to open Labware MiniHub Diagnostics. For details, see “MiniHub 
ActiveX control” on page 77.

Related information

For information about... See...

MiniHub ActiveX control “MiniHub ActiveX control” on page 77

Checking the hub’s current 
position

“Checking the MiniHub’s current 
position” on page 44

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Changing the rotation speed “Changing the rotation speed” on 
page 47 

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 49

Teaching the home position “Setting the home position” on page 34

Clearing controller faults “Checking the error indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 30
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Checking the MiniHub’s current position

About the Cassette value

The Cassette value in the Controls tab indicates the cassette that is currently 
facing the robot. For example, a Cassette value of 3 indicates that cassette 3 is 
facing the robot. A dash (—) indicates that the MiniHub is between cassette 
positions.

About the Position value

The Position value in the Controls tab indicates the position of the MiniHub 
relative to its home position. Position values range from 0–360°, 
counterclockwise from the home position. The Cassette values correspond to 
the following position values:

If the MiniHub is between cassette positions, other position values will be 
displayed. For example, if the MiniHub is exactly between cassette 1 (0°) and 
cassette 2 (90°), the Position value is 45°.

Cassette Position value

1, or home 0°

2 90°

3 180°

4 270°

1

2
3

4
0°

90°

180°

270°
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Procedure

To check the current position of the Labware MiniHub:

In the Controls tab, check the values in the Cassette and Position boxes.

Related information

For information about... See...

Labware MiniHub Diagnostics “About Labware MiniHub Diagnostics” 
on page 42

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Changing the rotation speed “Changing the rotation speed” on 
page 47 

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 49

Teaching the home position “Setting the home position” on page 34

Clearing controller faults “Checking the error indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 30
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Enabling and disabling the motor

About this topic

Disabling the MiniHub motor allows you to rotate the MiniHub by hand. You 
might want to do this when you:

• Set the home position.

• Want to remove labware from specific shelves after a run error occurs.

After setting the home position or fixing the error, you can enable the hub’s 
motor to resume operation.

Procedure

To enable or disable the Labware MiniHub motor:
In the Controls tab, click Enable or Disable.

Note: When the motor is enabled, the green Enabled light turns on in the Motor 
area. When the motor is disabled, the Enabled light turns off.

Related information

CAUTION The Labware MiniHub might rotate slightly when you enable the motor. 
Obstructing the Labware MiniHub while it is rotating will cause an error.

For information about... See...

Labware MiniHub Diagnostics “About Labware MiniHub Diagnostics” 
on page 42

Checking the hub’s current 
position

“Checking the MiniHub’s current 
position” on page 44

Changing the rotation speed “Changing the rotation speed” on 
page 47 
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Changing the rotation speed

Procedure

You can select the speed at which the Labware MiniHub turns while you are 
making adjustments in Labware MiniHub Diagnostics. For example, you can 
select the Slow speed when you are setting up or troubleshooting the hub.

Note: To set the rotation speed for protocol runs, use the Speed selection in 
the Profiles tab.

To select the diagnostic rotation speed:
In the Controls tab, select one of the following speeds from the Speed list:

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 49

Teaching the home position “Setting the home position” on page 34

Clearing controller faults “Checking the error indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 30

For information about... See...

Speed Description

Slow Rotates the MiniHub at 25% of the factory- set 
maximum speed.
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Related information

Medium Rotates the MiniHub at 50% of the factory- set 
maximum speed.

Fast Rotates the MiniHub at 100% of the factory- set 
maximum speed.

Speed Description

For information about... See...

Labware MiniHub Diagnostics “About Labware MiniHub Diagnostics” 
on page 42

Checking the current position of 
the Labware MiniHub

“Checking the MiniHub’s current 
position” on page 44

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 49

Teaching the home position “Setting the home position” on page 34

Clearing controller faults “Checking the error indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 30
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Rotating the MiniHub to a specific position

About this topic

You can rotate the Labware MiniHub using one of the following methods:

• Rotating to a specific cassette

• Rotating the MiniHub in set increments

• Rotating the MiniHub to a specific position relative to home

Rotating to a specific cassette

You can rotate the MiniHub so that the desired cassette is facing the robot.

To rotate to a specific cassette:

1 Move the automation system or BenchCel robot away from the hub. See the 
automation system user documentation or the BenchCel Microplate 
Handling Workstation User Guide for instructions.

2 In the Controls tab, select the desired cassette from the Rotate to Cassette list, 
and then click Rotate to Cassette. The MiniHub rotates until the desired 
cassette faces the robot. The Cassette box displays the selected cassette.

Rotating the MiniHub in set increments

You can rotate the MiniHub clockwise or counterclockwise in set increments 
from its current position.

To rotate the MiniHub in set increments:

1 Move the automation system or BenchCel robot away from the hub. See the 
automation system user documentation or the BenchCel Microplate 
Handling Workstation User Guide for instructions.

                                                        

CAUTION Obstructing the Labware MiniHub while it is rotating will cause an error.
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2 In the Controls tab, click one of the following:

3 Click the Jog counterclockwise or Jog clockwise button again to rotate the 
MiniHub the specified number of degrees.

Rotating the MiniHub to a specific position relative to home

You can rotate the stage so that cassette 1 is at a specified number of degrees 
from the home position, 0°.

To rotate the MiniHub a specific number of degrees:

1 Move the automation system or BenchCel robot away from the hub. See the 
automation system user documentation or the BenchCel Microplate 
Handling Workstation User Guide for instructions.

2 In the Controls tab, type the number of degrees in the Rotate to degree box, 
and then click Rotate to degree. 

If you specified an angle between 1° and 180°, the software will rotate the 
MiniHub clockwise. If you specified an angle greater 180°, the software will 
rotate the MiniHub counterclockwise.

Command Description

Jog counterclockwise Displays the number of degrees to rotate 
counterclockwise, relative to its current 
position. Select the desired number of degrees.

Jog clockwise Displays the number of degrees to rotate 
clockwise, relative to its current position. Select 
the desired number of degrees.
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Related information

For information about... See...

Labware MiniHub Diagnostics “About Labware MiniHub Diagnostics” 
on page 42

Checking the current position of 
the Labware MiniHub

“Checking the MiniHub’s current 
position” on page 44

Changing the rotation speed “Changing the rotation speed” on 
page 47 

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Teaching the home position “Setting the home position” on page 34

Clearing controller faults “Checking the error indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 30
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Checking the error indicator

About controller faults

If an error occurs during operation, the error indicator light at the base turns 
on and flashes slowly. In Labware MiniHub Diagnostics, the Fault light also 
turns on.

Read the message in the error dialog box, and then check “Troubleshooting” on 
page 61 for actions you can take to resolve the errors. After the error is 
resolved, the Error light at the base and in the dialog box turn off.

Related information

For information about... See...

Labware MiniHub Diagnostics “About Labware MiniHub Diagnostics” 
on page 42

Checking the current position of 
the Labware MiniHub

“Checking the MiniHub’s current 
position” on page 44

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Changing the rotation speed “Changing the rotation speed” on 
page 47 

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 49

Teaching the home position “Setting the home position” on page 34

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 30
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Viewing the log area

About the log area

The log area displays all of the commands issued and the status of the actions 
while you are working in the dialog box. Error conditions are displayed in red 
text.

If the Labware MiniHub is integrated in the VWorks software, the information 
displayed in the log area is also written to the VWorks log file.

Related information

For information about... See...

Labware MiniHub Diagnostics “About Labware MiniHub Diagnostics” 
on page 42

Checking the current position of 
the Labware MiniHub

“Checking the MiniHub’s current 
position” on page 44

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Changing the rotation speed “Changing the rotation speed” on 
page 47 

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 49

Teaching the home position “Setting the home position” on page 34
53Labware MiniHub User Guide



4   Using Labware MiniHub Diagnostics
Viewing the log area
Clearing controller faults “Checking the error indicator” on 
page 52

Profiles tab “Creating Labware MiniHub profiles” on 
page 30

For information about... See...
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Maintaining the Labware MiniHub

This chapter contains the following topics:

• “Cleaning the shelves” on page 56

• “Replacing fuses” on page 57
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Cleaning the shelves
Cleaning the shelves

Procedure

Be sure to clean up spills on any part of the Labware MiniHub immediately 
after a protocol run. Use a clean soft cloth to remove the spill. Use clean 
water or an alcohol- based cleaning solution to remove dirt. Do not use 
corrosive cleaning solutions.

Related information

WARNING  Always turn off the Labware MiniHub and shut down the lab automation 
system or workstation before performing any maintenance procedure. See “Turning on and 
turning off the Labware MiniHub” on page 17 and the lab automation system user 
documentation.

For information about... See...

Safety information Labware MiniHub Safety and 
Installation Guide

Replacing fuses “Replacing fuses” on page 57

Reporting problems “Reporting problems” on page 68
56 Labware MiniHub User Guide



5   Maintaining the Labware MiniHub
Replacing fuses
Replacing fuses

About this topic

This topic explains how to replace fuses in the Labware MiniHub power 
supply.

Fuse location

The Labware MiniHub has four fuses that are accessible from the back of the 
power supply: two in the rectangular housing below the power inlet, one in 
each of the two circular housings labeled T12 A, 250 V.

Materials and tools

Make sure you have the following:

• 1/4- in slotted- blade screwdriver

• Replacement fuse(s) 

Before you start

Make sure you:

WARNING  Only administrators and experienced personnel should perform the 
procedure in this topic. Alternatively, contact Automation Solutions Technical Support for 
assistance.

100 - 240 V~
4 A
50/60 Hz

T 4 A 250 V

24 V 24 V

1 2

Item Fuse housing label Function Rating (time-delayed)

1 T4A 250V 120–240 V~ power input 4 A, 250 V

2 T12A 250V 24 V DC power output 12 A, 250 V

CAUTION Using an incorrect fuse can damage the Labware MiniHub.

WARNING  Always turn off the Labware MiniHub and shut down the lab automation 
system or workstation before performing any maintenance procedure. 

WARNING  Always disconnect the power cord from the power supply before 
performing any maintenance procedure.
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1 Turn off the Labware MiniHub and the lab automation system or 
workstation. See “Turning on and turning off the Labware MiniHub” on 
page 17 and the lab automation system user documentation.

2 Disconnect the power cord from the Labware MiniHub power supply. See 
Labware MiniHub Safety and Installation Guide.

Replacing the 4 A fuses

To replace a 4 A fuse:

1 At the power inlet, use the screwdriver to pry open the housing, and then 
carefully pull out the fuse cartridge by hand. Two fuses sit in the cartridge.

2 Replace the blown fuse in the fuse cartridge. (A blown fuse has a broken 
filament.)

3 Slide the fuse cartridge back into the fuse housing.

4 Press the cartridge securely into the closed position.

5 Plug in the power cable at the power inlet.

Replacing the 12 A fuses

To replace one of the 12 A fuses:

1 Using the screwdriver, turn the fuse holder counterclockwise one- eighth 
turn (1). The fuse holder moves outward (2).

~

T 4 A 250 V
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2 Remove the fuse holder from the housing.

3 Pull out the blown fuse (1) and insert the new fuse (2). (A blown fuse has 
a broken filament.)

4 Insert the fuse and holder back into the housing.

5 While pressing the fuse holder into the housing, turn the fuse holder 
clockwise one- eight turn using the screwdriver.

 

Related information

1 2

1 2

For information about... See...

Safety information Labware MiniHub Safety and 
Installation Guide

Electrical requirements Labware MiniHub Safety and 
Installation Guide

Cleaning the shelves “Cleaning the shelves” on page 56

Reporting problems “Reporting problems” on page 68
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Troubleshooting

This chapter contains the following topics:

• “Troubleshooting hardware problems” on page 62

• “Troubleshooting error messages” on page 65

• “Reporting problems” on page 68
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Troubleshooting hardware problems

About this topic

This topic lists commonly encountered hardware problems, the causes of the 
problems, and ways to resolve the problems:

• “Communication or power problems” on page 62

• “Homing and other problems” on page 63

If you are still experiencing problems with the Labware MiniHub after trying 
the solutions, contact Automation Solutions Technical Support.

Communication or power problems

Problem Cause Solution

The Labware MiniHub 
does not turn on.

The electrical requirements are not 
met.

Make sure the electrical 
requirements are met. See the 
Labware MiniHub Safety and 
Installation Guide.

The Labware MiniHub is not 
connected to the power supply or 
the power source.

Connect the Labware MiniHub to the 
power supply and power source. See 
Labware MiniHub Safety and 
Installation Guide.

One or more of the fuses are 
blown.

Replace the blown fuse(s). See 
“Replacing fuses” on page 57.

If the fuses are blown immediately 
after replacement, stop using the 
device and contact Automation 
Solutions Technical Support.

If sound of the fan in the power 
supply is audible, and the Labware 
MiniHub is working properly, the 
Labware MiniHub is turned on. 
However, the light in the switch is 
broken.

Contact Automation Solutions 
Technical Support to replace the 
power switch.
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Homing and other problems

The power switch light 
is on, but the Labware 
MiniHub does not 
rotate.

The Labware MiniHub is not 
initialized.

In the Labware MiniHub Diagnostics 
Profiles tab, make sure the correct 
profile and COM port are selected, 
and then click Initialize this profile.

The Labware MiniHub is not 
connected to the controlling 
computer.

Make sure the supplied Ethernet 
cable with serial adaptor connects 
the Labware MiniHub and the 
controlling computer.

The device uses serial 
communication over the Ethernet 
cable. Make sure the serial- adaptor 
end of the cable is connected to a 
serial port at the controlling 
computer.

Make sure the serial port selected in 
the Profiles tab matches the serial 
port used for this device.

An error occurred. Check the Error light on the base. If 
the light is on, an error has 
occurred. To clear the error, in 
Labware MiniHub Diagnostics 
Controls tab, click Clear Fault.

Problem Cause Solution

Problem Cause Solution

The Labware MiniHub 
does not home.

The home position is set 
incorrectly.

Reset the home position and try 
again. See “Setting the home 
position” on page 34.

The encoder might be dirty or 
damaged.

Contact Automation Solutions 
Technical Support.

A communication error might have 
occurred.

Make sure the supplied Ethernet 
cable with serial adaptor connects 
the Labware MiniHub and the 
controlling computer. Also, make 
sure the serial port selected in the 
Profiles tab matches the serial port 
used for this device. Check that the 
profile is initialized.

The robot does not 
place or pick labware 
correctly at the 
Labware MiniHub.

The robot teachpoints might be set 
incorrectly, the Labware MiniHub 
has moved after the teachpoints 
were set, or the shelves are bent.

Check and reset the robot 
teachpoints. See “Setting robot 
teachpoints” on page 39. See also the 
automation system robot user 
documentation or the BenchCel 
Microplate Handling Workstation 
User Guide for instructions.

Check for and replace bent shelves.
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Related information

The Labware MiniHub 
has stopped and the 
Error light at the base 
is on.

An obstacle prevented the Labware 
MiniHub from rotating, or a 
computer error prevented 
communication with the device.

Remove the obstacle, click Retry, and 
resume operation.

Re- initialize the Labware MiniHub. If 
the problem persists, power cycle the 
device.

Problem Cause Solution

For information about... See...

Labware MiniHub component 
names

“Hardware overview” on page 5

Hardware problems “Troubleshooting hardware problems” 
on page 62

Safety Labware MiniHub Safety and 
Installation Guide

Reporting problems to Agilent 
Technologies

“Reporting problems” on page 68
64 Labware MiniHub User Guide



6   Troubleshooting
Troubleshooting error messages
Troubleshooting error messages

About this topic

The following tables list commonly encountered error messages, the causes of 
the errors, and ways to resolve the errors. The error messages are listed by the 
following categories:

• Communication errors

• Fatal errors

• Non- fatal errors

• Warnings

If you are still experiencing problems with the Labware MiniHub after trying 
the solutions, or if an error not on the list is displayed, contact Automation 
Solutions Technical Support.

For protocol- related errors, see the automation system software user guide, 
such as the VWorks Automation Control User Guide.

Communication errors

The following error messages are caused by communication problems:

• Bad CRC8 in receive packet

• Connection not open

• Error access critical section creation failed

• Event queue is full

• Event thread creation failed

• Log access critical section or log timer creation failed

• Receive packet timed out

• Reply list critical section creation failed

• Synchronization failed

• Unable to open connection

• Unable to send packet

Check the following causes and try the corresponding solutions:

Cause Solution

The Labware MiniHub is 
connected to the incorrect serial 
port, or the serial port is already 
in use by another device.

Check and make sure the correct serial 
port is used at the controlling computer.

The Labware MiniHub is 
disconnected from serial port.

Check the Ethernet cable connection at 
the power supply and at the controller 
computer.

The Labware MiniHub is not 
turned on.

Turn on the Labware MiniHub.
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Fatal errors

The following fatal error messages are typically caused by hardware errors or 
problems in the hardware, firmware, or controller. If one of the messages is 
displayed, contact Automation Solutions Technical Support.

• Amplifier Not Responding

• Register File Checksum Error

• Register File Version Error

Non-fatal errors

The following non- fatal error messages are typically caused by an obstruction 
or damage to the device.

• Amplifier Short Circuit Error

• Average Current Error

• Excessive Following Error

• Profile Queue Overflow Error

• Stator Alignment Error

Check the following causes and try the corresponding solutions:

Warnings

The following warning messages are displayed if electrical fluctuations occur in 
the current or voltage.

• Communication Queue Full

• Done Zone Timeout

• Over Current

• Over Voltage

• Profile Queue Overflow

• Profile Queue Underflow

• Under Voltage

Check the following causes and try the corresponding solutions:

Cause Solution

An obstacle prevented the 
Labware MiniHub from rotating.

Remove the obstacle, and then try 
rotating the Labware MiniHub again.

Hardware components in the 
Labware MiniHub are damaged.

Contact Automation Solutions Technical 
Support.

Cause Solution

The electrical requirements are 
not met.

Make sure the electrical requirements are 
met. See the Labware MiniHub Safety 
and Installation Guide.

The circuit to which the Labware 
MiniHub is connected is noisy or 
overloaded.

Check for noise or overloading in the 
electrical circuit. Install a UPS as a 
power backup.
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Related information

The power supply is failing. Replace the power supply. Contact 
Automation Solutions Technical Support.

Cause Solution

For information about... See...

Labware MiniHub component 
names

“Hardware overview” on page 5

Hardware problems “Troubleshooting hardware problems” 
on page 62

Safety Labware MiniHub Safety and 
Installation Guide

Reporting problems to Agilent 
Technologies

“Reporting problems” on page 68
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Reporting problems

Contacting Automation Solutions Technical Support 

If you find a problem with the Labware MiniHub, contact Automation Solutions 
Technical Support at one of the following:

Europe

Phone: +44 (0)1763850230

email: euroservice.automation@agilent.com

US and rest of world

Phone: 1.800.979.4811 (US only) or +1.408.345.8011

email: service.automation@agilent.com

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready. You can locate the serial number on the side of the base, 
as shown.

Figure MiniHub device serial number label location

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Relevant software version number (for example, automation control 
software, diagnostics software, ActiveX control software, and firmware)

• Error message text (or screen capture of the error message dialog box)

• Relevant files, such as log files

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments in an email to 
documentation.automation@agilent.com.
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Related information

For information about... See...

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 62

Software error messages “Troubleshooting error messages” on 
page 65

Safety Labware MiniHub Safety and 
Installation Guide

Reporting problems to Agilent 
Technologies

“Reporting problems” on page 68
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Quick reference

This appendix contains the following topics:

• “Profiles tab” on page 72

• “Controls tab” on page 74
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A   Quick reference
Profiles tab
Profiles tab

Profile Management area

                                                        

Selection or command Description

Profile name Displays the selected profile. Also allows you 
to select from the list of available profiles.

Create a new profile Creates a new profile.

Create a copy of this profile Creates a duplicate copy of the selected 
profile.

Rename this profile Renames the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the device using 
the selected profile.
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Profiles tab
Profile Settings area

Log table and log area

The table below the Profile Settings area lists all of the changes you have made 
in the Profiles Settings area.

The log area displays all commands and actions issued in the Labware 
MiniHub Diagnostics dialog box. The area is visible in the Profiles tab and the 
Controls tab.

Commands

Related information

Selection or parameter Description

Serial port The COM port of the computer that is 
connected to the Labware MiniHub.

Slots Per Cassette The number of shelves in each MiniHub 
cassette.

Speed The rotational speed of the MiniHub during 
protocol runs. The selections are:

• Slow. Turns the MiniHub at 25% of the 
factory- set maximum speed.

• Medium. Turns the MiniHub at 50% of the 
factory- set maximum speed.

• Fast. Turns the MiniHub at 100% of the 
factory- set maximum speed.

To set the rotation speed while you are working 
in diagnostics, go to the Controls tab.

Command Description

About Displays the Labware MiniHub Diagnostics 
version number and copyright information.

For information about... See...

Profiles “About profiles” on page 30

Creating a profile “Creating a Labware MiniHub profile” 
on page 31

Editing profiles “Editing profiles” on page 33

Managing profiles “Managing profiles” on page 33

Controls tab “Controls tab” on page 74
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Controls tab
Controls tab

Status area and commands

Box name or command Description

Cassette The current cassette at the home position.

Position The current position of the MiniHub, in 
degrees.

Speed The rotational speed of the MiniHub while you 
are in diagnostics. The selections are:

• Slow. Turns the MiniHub at 25% of the 
factory- set maximum speed.

• Medium. Turns the MiniHub at 50% of the 
factory- set maximum speed.

• Fast. Turns the MiniHub at 100% of the 
factory- set maximum speed.

To set the rotation speed for protocol runs, go 
to the Profiles tab.

Fault The light that indicates whether the MiniHub 
has encountered an error. If the light is on, an 
error has occurred.
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Controls tab
Movement area

Motor area

Teach area

Related information

Selection, parameter, or 
command

Description

Jog counterclockwise Turns the MiniHub counterclockwise by the 
selected degree increment.

Jog clockwise Turns the MiniHub clockwise by the selected 
degree increment.

Rotate to degrees Turns the MiniHub so that cassette 1 is at the 
specified number of degrees from the home 
position.

Rotate to cassette Turns the MiniHub so that the selected cassette 
is at the home position.

Command Description

Enable Turns on the MiniHub motor.

Disable Turns off the MiniHub motor.

Parameter or command Description

Go home Turns the MiniHub to the home position.

Teach Home Sets the home position.

For information about... See...

Checking the current position of 
the Labware MiniHub

“Checking the MiniHub’s current 
position” on page 44

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 46

Moving to a specific cassette “Rotating the MiniHub to a specific 
position” on page 49

Clearing controller faults “Checking the error indicator” on 
page 52

Changing the hub’s rotation speed “Profiles tab” on page 72

Setting the home position “Setting the home position” on page 34
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Controls tab
Profiles tab “Profiles tab” on page 72

For information about... See...
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MiniHub ActiveX control

This  contains the following topics:

• “About the MiniHub ActiveX control” on page 78

• “Properties” on page 79

• “Methods” on page 82

• “Events” on page 97

The MiniHub ActiveX has been verified to work with both Visual 
C++ and Visual Studio .NET in Visual Studio 2008.
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About the MiniHub ActiveX control
About the MiniHub ActiveX control

What is the MiniHub ActiveX control

The MiniHub ActiveX control is the software component that allows third- party 
lab automation systems to interact with the Labware MiniHub.

How the MiniHub ActiveX control is used

In an Agilent Technologies automation system that is running the VWorks 
software, ActiveX interfaces are not used to communicate with devices. 
However, some integrations, such as those with LIMS, require that a third-
party application control the Labware MiniHub. The MiniHub ActiveX control 
enables third- party applications to interface with the Labware MiniHub. 

Each ActiveX control consists of a collection of the following:

• Methods. Functions that can be called to invoke individual operations

• Properties. Attributes or features of the ActiveX control

• Events. Notifications that methods have completed or resulted in errors

To ensure proper integration, you must know the available methods and 
properties for the ActiveX control.

The following diagram illustrates the use of the MiniHub ActiveX control in a 
lab automation system environment. Actions you perform are conducted 
through ActiveX methods. System responses are relayed back through ActiveX 
events or through return values and variables passed to methods.

Note: Although the MiniHub ActiveX control generates events, the third- party 
application must implement handlers for them.

 

ActiveX,
including
diagnostics

Computer

Third-party 
lab automation 
software

Serial
port

Automation
Solutions
device

Serial commands Methods

Events
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Related information

Properties

About this topic

This topic describes the following properties:

• “Blocking” on page 79

• “ControlPicture” on page 80

Blocking

VARIANT_BOOL Blocking

Description
Determines whether methods should block until completion or return 
immediately for asynchronous operation.

Acceptable values
• VARIANT_TRUE (C++) or True (Visual Basic .NET). The ActiveX control is 

forced to block or wait until a method completes before it returns control 
to the caller.

• VARIANT_FALSE (C++) or False (Visual Basic .NET). Returns control to the 
application immediately, and the caller should handle the events 
accordingly.

Default value
VARIANT_FALSE (C++) or False (Visual Basic .NET)

Blocking affects some methods differently. See each method’s description for 
the effect. Unless otherwise noted:

• In non- blocking mode (Block = VARIANT_FALSE or False), a method:

– Starts another thread of execution to perform the given method, 
returning control to the application immediately.

– Returns 0 on launching a new thread successfully; otherwise, returns 
nonzero, and an Error event is fired.

– If the method is successful, an event indicating completion is fired; if 
unsuccessful, an Error event is fired.

For information about... See...

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX properties “Properties” on page 79

MiniHub ActiveX methods “Methods” on page 82

MiniHub ActiveX events “Events” on page 97
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• In blocking mode (Block = VARIANT_TRUE or True), a method:

– Is executed.

– Returns 0 if it completes successfully; returns nonzero otherwise.

• Error message can be reviewed by calling GetLastError().

Visual C++ Example
// set the MiniHub in blocking mode

VARIANT_BOOL blocking=VARIANT_TRUE;

m_Minihub.PutBlocking (blocking);

// set the MiniHub in non-blocking mode

blocking=VARIANT_FALSE;

m_Minihub.PutBlocking (blocking);

// returns the blocking value

blocking = m_Minihub.GetBlocking ( );

// user should handle events if non-blocking!

Visual Basic .NET Example
‘set Labware MiniHub in blocking mode

Minihub1.Blocking=True

‘set Labware MiniHub in non-blocking mode

Minihub1.Blocking=False

‘returns the blocking value

Dim bMode as Boolean

bMode = Minihub1.Blocking

‘user should handle events if non-blocking!

ControlPicture

IPictureDisp*ControlPicture

Description
A read- only picture of the Labware MiniHub that can be used in the 
container’s application.

Parameters
None

Visual C++ Example
/* the CPicture class will be imported into your project

when the ActiveX is installed */

CButton button;

// create a button

CPicture MinihubPic;

// retrieve the picture

MinihubPic = m_Minihub.GetControlPicture();

// paint the bitmap onto the button

button.SetBitmap((HBITMAP) MinihubPic.GetHandle());
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Visual Basic .NET Example
Dim iPicture As System.Drawing.Image = 
Minihub1.ControlPicture()

button.BackgroundImage = iPicture

Related information

For information about... See...

MiniHub ActiveX control “About the MiniHub ActiveX control” on 
page 78

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX methods “Methods” on page 82

MiniHub ActiveX events “Events” on page 97
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Methods
Methods

About this topic

The topic describes the following methods:

• “Abort” on page 82

• “AboutBox” on page 83

• “Close” on page 83

• “DisableMotor” on page 84

• “EnableMotor” on page 84

• “EnumerateProfiles” on page 85

• “GetActiveXVersion” on page 86

• “GetCassetteCount” on page 86

• “GetCurrentCassette” on page 87

• “GetCurrentPosition” on page 87

• “GetFirmwareVersion” on page 88

• “GetHomePositionOffset” on page 88

• “GetLastError” on page 89

• “GetMotorStatus” on page 89

• “GetSlotCount” on page 90

• “GetSpeed” on page 90

• “Ignore” on page 91

• “Initialize” on page 91

• “Jog” on page 92

• “Retry” on page 92

• “RotateToCassette” on page 93

• “RotateToDegree” on page 93

• “RotateToHomePosition” on page 94

• “SetSpeed” on page 94

• “ShowDiagsDialog” on page 95

• “TeachHome” on page 95

Abort

long Abort(void)

Description
Aborts a current task that is in the error state and clears the error.

Parameters
None

Return
0 if successful

Other value if there was an error
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Visual C++ example
long lres = m_Minihub.Abort();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Abort()

AboutBox

void AboutBox(void)

Description
Displays the Labware MiniHub About dialog box that contains the ActiveX 
version number.

Parameters
None

Return
None

Visual C++ example
m_Minihub.AboutBox();

Visual Basic .NET example
Minihub1.AboutBox()

Close

long Close(void)

Description
Closes the intialized Labware MiniHub profile and disconnects from the 
Labware MiniHub.

Parameters
None

Return
0 if successful, and fires the CloseComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Close();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Close()
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DisableMotor

long DisableMotor(void)

Description
Turns off the MiniHub’s motor.

Parameters
None

Return
0 if successful, and fires the DisableMotorComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.DisableMotor();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.DisableMotor()

EnableMotor

long EnableMotor(void)

Description
Turns on the MiniHub’s motor.

Parameters
None

Return
0 if successful, and fires the EnableMotorComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.EnableMotor();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.EnableMotor()
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EnumerateProfiles

VARIANT EnumerateProfiles(void)

Description
Retrieves a list of defined profiles. The strings in this array are the profile 
names that should be used for the Initialize method.

Parameters

None

Return
An array of profile names

Visual C++ example
VARIANT vProfiles = m_Minihub.EnumerateProfiles();

SAFEARRAY *psa = vProfiles.parray;

BSTR* bstrArray; 

if

(FAILED(SafeArrayAccessData(psa,reinterpret_cast<void**>( 
&bstrArray))))

{

    VariantClear(&vProfiles);

    return;

}

for (ULONG i = 0; i < psa->rgsabound[0].cElements; i++)

{

    MessageBox(CString(bstrArray[i])));

}

SafeArrayUnaccessData(psa);

VaraintClear(&vProfiles);

Visual Basic .NET example
Dim i as Integer

Dim profileNames() As String

profileNames = Minihub1.EnumerateProfiles()

For i = 0 To profileNames.GetLength(0) - 1

MsgBox profileNames(i)

Next
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GetActiveXVersion

BSTR GetActiveXVersion(void)

Description
Retrieves the MiniHub ActiveX software version number.

Parameters
None

Return
ActiveX software version number (string)

Visual C++ example
CString ActiveXVer = m_Minihub.GetActiveXVersion();

Visual Basic .NET example
Dim sVersion As String

sVersion = Minihub1.GetActiveXVersion()

GetCassetteCount

long GetCassetteCount(short *nCassetteCount)

Description
Retrieves the cassette count. 

Note: In this version, the cassette count is always 4.

Parameters
short *nCassetteCount

Cassette count value

Return
0 if successful, and fires the GetCassetteCountComplete event

Other value if there was an error

Visual C++ example
short ncassettes;

long lres = m_Minihub.GetCassetteCount(&ncassettes);

Visual Basic .NET example
Dim ires as Integer

Dim shCassCount As Short = 0

ires = Minihub1.GetCassetteCount(shCassCount)
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GetCurrentCassette

long GetCurrentCassette(short* nCassetteIndex)

Description
Retrieves the ID of the cassette that is currently at the home position.

Parameters
short* nCassetteIndex

The ID of the cassette that is currently at the MiniHub’s home position

Return
0 if successful, and fires the GetCurrentCassetteComplete event

Other value if there was an error

Visual C++ example
short curcas;

long lres = m_Minihub.GetCurrentCassettePosition(&curcas);

Visual Basic .NET example
Dim ires as Integer

Dim shCassette As Short = 0

ires = Minihub1.GetCurrentCassette(shCassette)

GetCurrentPosition

long GetCurrentPosition(float* fPositionInDegree)

Description
Retrieves the MiniHub’s current position.

Parameters
float* fPositionInDegree

The current position (0–360) in degrees

Return
0 if successful, and fires the GetCurrentPositionComplete event

Other value if there was an error

Visual C++ example
short  curpos;

long lres = m_Minihub.GetCurrentPosition(&curpos);

Visual Basic .NET example
Dim ires as Integer

Dim siPos As Single = 0

ires = Minihub1.GetCurrentPosition(siPos)
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GetFirmwareVersion

BSTR GetFirmwareVersion(void)

Description
Retrieves the Agile controller firmware version number.

Parameters
None

Return
Agile controller version number (string)

Visual C++ example
CString str = m_Minihub.GetFirmwareVersion ();

Visual Basic .NET example
Dim sFirmVer As Strings

sFirmVer = Minihub1.GetFirmwareVersion()

GetHomePositionOffset

long GetHomePositionOffset(float* fPosition)

Description
Retrieves the MiniHub’s home position offset, which is the encoder counter 
value.

Parameters
float* fPosition

The home position offset value

Return
0 if successful, and fires the GetHomePositionOffsetComplete event

Other value if there was an error

Visual C++ example
float homepos;

long lres = m_Minihub.GetHomePositionOffset(&homepos);

Visual Basic .NET example
Dim ires as Integer

Dim siOffset As Single

ires = Minihub1.GetHomePositionOffset(siOffset)
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GetLastError

BSTR GetLastError(void)

Description
Retrieves the last known error condition.

Parameters
None

Return
An error string

Visual C++ example
CString str = m_Minihub.GetLastError();

Visual Basic .NET example
Dim sError As String = ""

sError = Minihub1.GetLastError()

GetMotorStatus

long GetMotorStatus(VARIANT_BOOL* bServoStatus)

Description
Checks to see whether the motor is on.

Parameters
VARIANT_BOOL* bServoStatus

The state of the motor:

• VARIANT_TRUE (C++) or True (Visual Basic .NET) if motor is on

• VARIANT_FALSE (C++) or False (Visual Basic .NET) if motor is off

Return
0 if successful, and fires the GetMotorStatusComplete event

Other value if there was an error

Visual C++ example
VARIANT_BOOL ismotoron;

long lres = m_Minihub.GetMotorStatus(&ismotoron);

Visual Basic .NET example
Dim ires as Integer

Dim bMotorStatus As Boolean

ires = Minihub1.GetMotorStatus(bMotorStatus)
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GetSlotCount

long GetSlotCount(short *nSlotCount)

Description
Retrieves the slot count (the total number of slots in a cassette).

Parameters
short *nSlotCount

The slot count value

Return
0 if successful, and fires the GetSlotCountComplete event

Other value if there was an error

Visual C++ example
short nslots;

long lres = m_Minihub.GetSlotCount(&nslots);

Visual Basic .NET example
Dim ires as Integer

Dim shSlots As Short

ires = Minihub1.GetSlotCount(shSlots)

GetSpeed

long GetSpeed(short* pSpeed);

Description
Retrieves the MiniHub’s current speed.

Parameters
short* pSpeed

The current speed: 0 (slow), 1 (medium), or 2 (fast).

Return
0 if successful

Other value if there was an error

Visual C++ example
short nSpeed;

long lres = m_Minihub.GetSpeed(&nSpeed);

Visual Basic .NET example
Dim ires as Integer

Dim shSpeed As Short

ires = Minihub1.GetSpeed(shSpeed)
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Ignore

long Ignore(void)

Description
Ignores the previously issued error and moves to the next step in the task. 
This is not a recommended course of action, as the errors are issued for a 
reason. However, ignoring some errors can be appropriate if the operator 
understands the implications.

Parameters
None

Return
0 if successful

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Ignore();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Ignore()

Initialize

long Initialize(BSTR Profile)

Description
Initializes the profile and starts communication with the Labware MiniHub 
using the parameters set in the profile. The profile specifies the serial 
connection used to communicate with the Labware MiniHub. The parameters 
for each profile can be adjusted in the Diagnostics dialog box on the Profiles 
page (by calling the ShowDiagsDialog method).

Parameters
BSTR Profile

The name of the profile to be used for initialization.

Return
0 if successful, and fires the InitializeComplete event

Other value if there was an error

Visual C++ example
// connect via serial connection specified in the profile

long lres = 
m_Minihub.Initialize(_bstr_t("MiniHubprofile"));

Visual Basic .NET example
‘connect via serial connection specified in the profile

Dim ires as Integer

ires = Minihub1.Initialize(“MiniHub profile")
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Jog

long Jog(float fDegree, VARIANT_BOOL bClockwise)

Description
Rotates the MiniHub a specified number of degrees from its current position.

Parameters
float fDegree

The number of degrees relative to the current position.

VARIANT_BOOL bClockwise

The direction of the rotation. Set Clockwise to VARIANT_TRUE (C++) or 
True (Visual Basic .NET) to rotate the stage clockwise. Set Clockwise to 
VARIANT_FALSE (C++) or False (Visual Basic .NET) to rotate the stage 
counterclockwise.

Return
0 if successful, and fires the JogComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Jog(30.0, VARIANT_TRUE);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Jog(30.0,True)

Retry

long Retry(void)

Description
Retries the last action after an error occurred.

Parameters
None

Return
0 if successful

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Retry();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Retry()
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RotateToCassette

long RotateToCassette(short nCassetteIndex)

Description
Rotates the MiniHub so that the specified cassette is at the 0° position.

Parameters
short nCassetteIndex

The cassette number: 1, 2, 3, or 4.

Return
0 if successful, and fires the RotateToCassetteComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.RotateToCassette(1);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.RotateToCassette(1)

RotateToDegree

long RotateToDegree(float fDegree)

Description
Rotates the MiniHub a specified number of degrees.

Parameters
float fDegree

The number of degrees to rotate the MiniHub. A positive value rotates the 
MiniHub clockwise. A negative value rotates the MiniHub counterclockwise.

Return
0 if successful, and fires the RotateToDegreeComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.RotateToDegree(90.0);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.RotateToCassette(90.0)
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RotateToHomePosition

long RotateToHomePosition(void)

Description
Rotates the MiniHub so that cassette 1 is at the 0° position. This method is 
equivalent to the Go Home command in Labware MiniHub Diagnostics.

Parameters
None

Return
0 if successful, and fires the RotateToHomePositionComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.RotateToHomePosition();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.RotateToHomePosition()

SetSpeed

long SetSpeed(short nSpeed)

Description
Sets the MiniHub’s rotation speed.

Parameters
short nSpeed

The speed value: 0 (slow), 1 (medium), or 2 (fast).

Return
0 if successful

Other value if there was an error

Visual C++ example
long lres = m_Minihub.SetSpeed(0);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.SetSpeed(0)
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ShowDiagsDialog

void ShowDiagsDialog (VARIANT_BOOL modal, 
short securityLevel)

Description
Displays the Diagnostics dialog box that allows the operator to troubleshoot 
and correct problems. This method can be called before the Initialize method 
to create a profile. Contents displayed are based on the operator’s access level.

Parameters
VARIANT_BOOL modal

The mode of the dialog box. The dialog box displayed can be modal (does 
not permit users to access the parent window) or modeless (permits users 
to access the parent window). If the modal mode is desired, set modal to 
VARIANT_TRUE (C++) or True (Visual Basic .NET). If the modeless mode is 
desired, set modal to VARIANT_FALSE (C++) or False (Visual Basic .NET).

short securityLevel

The security level the operator has in the dialog box:

0 = Administrator

1 = Technician

2 = Operator

3 = Guest

- 1 = No access

Return
0 if successful

Other value if there was an error

Visual C++ example
m_Minihub.ShowDiagsDialog(VARIANT_TRUE,0);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.ShowDiagsDialog(True,0)

TeachHome

long TeachHome(void)

Description
Sets the teachpoint at the MiniHub’s current position. The home position 
should be when cassette 1 is at the 0° position.

Parameters
None

Return
0 if successful, and fires the TeachHomeComplete event

Other value if there was an error
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Visual C++ example
long lres = m_Minihub.TeachHome();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.TeachHome()

Related information

For information about... See...

MiniHub ActiveX control “About the MiniHub ActiveX control” on 
page 78

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX properties “Properties” on page 79

MiniHub ActiveX events “Events” on page 97
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Events

About this topic

This topic describes the following events:

• “CloseComplete” on page 97

• “DisableMotorComplete” on page 98

• “EnableMotorComplete” on page 98

• “Error” on page 98

• “GetCassetteCountComplete” on page 99

• “GetCurrentCassetteComplete” on page 99

• “GetCurrentPositionComplete” on page 99

• “GetHomePositionOffsetComplete” on page 100

• “GetMotorStatusComplete” on page 100

• “GetSlotCountComplete” on page 100

• “GetSpeedComplete” on page 101

• “InitializeComplete” on page 101

• “JogComplete” on page 101

• “RotateToCassetteComplete” on page 101

• “RotateToDegreeComplete” on page 102

• “RotateToHomePositionComplete” on page 102

• “SetSpeedComplete” on page 102

• “TeachHomeComplete” on page 102

CloseComplete

void CloseComplete(void)

Description
Occurs when the Close method is successful.

Parameters
None

Return
None
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DisableMotorComplete

void DisableMotorComplete(void)

Description
Occurs when the DisableMotor method is successful.

Parameters
None

Return
None

EnableMotorComplete

void EnableMotorComplete(void)

Description
Occurs when the EnableMotor method is successful.

Parameters
None

Return
None

Error

void Error(short Number, BSTR* Description, long Scode, 
BSTR Source, BSTR HelpFile, long HelpContext, 
VARIANT_BOOL* CancelDisplay)

Description
Fires when an error occurs during any non- blocking method execution.

Parameters
BSTR* Description

The description of the error.

VARIANT_BOOL* CancelDisplay

The option to hide the error message dialog box. Set to VARIANT_TRUE 
(C++) or True (Visual Basic .NET).

Note: short Number, long Scode, BSTR Source, BSTR HelpFile, and 
long HelpContext are not used.

Return
None
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GetCassetteCountComplete

void GetCassetteCountComplete(short nCassetteCount)

Description
Occurs when the GetCassetteCountComplete method is successful.

Parameters
short nCassetteCount

The number of cassettes in the MiniHub.

Return
None

GetCurrentCassetteComplete

void GetCurrentCassetteComplete(SHORT dCassette)

Description
Occurs when the GetCurrentCassettePosition method is successful.

Parameters
SHORT dCassette

The cassette number.

Return
None

GetCurrentPositionComplete

void GetCurrentPositionComplete(float fPosition)

Description
Occurs when the GetCurrentPosition method is successful.

Parameters
float fPosition

The position, in degrees.

Return
None
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GetHomePositionOffsetComplete

void GetHomePositionOffsetComplete(float fPosition)

Description
Occurs when the GetHomePositionOffset method is successful.

Parameters
float fPosition

The position, in degrees.

Return
None

GetMotorStatusComplete

void GetMotorStatusComplete(VARIANT_BOOL bServoStatus)

Description
Occurs when the GetMotorStatus method is successful.

Parameters
VARIANT_BOOL bMotorStatus

The status of motor. 

Return
None

GetSlotCountComplete

void GetSlotCountComplete(short nSlotCount)

Description
Occurs when the GetSlotCount method is successful.

Parameters
short nSlotCount

The number of slots in the cassettes. 

Return
None
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GetSpeedComplete

void GetSpeedComplete(short* pSpeed)

Description
Occurs when the GetSpeed method is successful.

Parameters
short pSpeed

The current speed: 0 (slow), 1 (medium), or 2 (fast).

Return
None

InitializeComplete

void InitializeComplete(void)

Description
Occurs when the Initialize method is successful.

Parameters
None

Return
None

JogComplete

void JogComplete(void)

Description
Occurs when the Jog method is successful.

Parameters
None

Return
None

RotateToCassetteComplete

void RotateToCassetteComplete(void)

Description
Occurs when the RotateToCassette method is successful.

Parameters
None

Return
None
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RotateToDegreeComplete

void RotateToDegreeComplete(void)

Description
Occurs when the RotateToDegrees method is successful.

Parameters
None

Return
None

RotateToHomePositionComplete

void RotateToHomePositionComplete(void)

Description
Occurs when the RotateToHomePosition method is successful.

Parameters
None

Return
None

SetSpeedComplete

void SetSpeedComplete(void)

Description
Occurs when the SetSpeed method is successful.

Parameters
None

Return
None

TeachHomeComplete

void TeachHomeComplete(void)

Description
Occurs when the TeachHome method is successful.

Parameters
None

Return
None
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Related information

For information about... See...

MiniHub ActiveX control “About the MiniHub ActiveX control” on 
page 78

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX properties “Properties” on page 79

MiniHub ActiveX methods “Methods” on page 82
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Orderable spare parts

This appendix lists the Labware MiniHub spare parts you can order 
from Automation Solutions. The topics are:

• “Ordering information” on page 106

• “Spare parts list” on page 106
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Ordering information
Ordering information

Contacting Customer Service

To order spare parts, contact Automation Solutions Customer Service using 
one of the following methods:

Related information

Spare parts list

Contact method Information

Telephone 1.866.428.9811

+1.408.345.8356

Email orders.automation@agilent.com

For information about... See...

Reporting problems “Reporting problems” on page 68

Spare parts list “Spare parts list” on page 106

Part name Part number

Shelves:

• System (G5471A) or BenchBot model (G5489A)

• BenchCel model (G5472A)

G5508- 10000

G5400- 00007

Spacers:

• 25.1 mm

• 8.4 mm

G5508- 20014

G5508- 20015

Rod, one of the following:

• System model

• BenchBot model

• BenchCel model

G5508- 20012

G5508- 20016

G5508- 20013

Standard integration plate (BenchCel model only) G5400- 20029

Fuses

• 4 A

• 12 A

5188- 8316

5188- 8347
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Spare parts list
To inquire about risers, contact Automation Solutions Customer Service. See 
“Contacting Customer Service” on page 106.

Related information

For information about... See...

Ordering information “Ordering information” on page 106

Reporting problems “Reporting problems” on page 68

Reconfiguring the shelves Labware MiniHub Safety and 
Installation Guide

Safety information Labware MiniHub Safety and 
Installation Guide
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Spare parts list
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controller faults, described, 52
Controls tab, 42, 74

D
Default Speed setting, 32
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device files
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creating, 20
defined, 19
saving, 20

devices
adding to device file, 21
communicating with, 25, 30
defined, 19
deleting in software, 22
initializing, 25

diagnostics software
described, 9
version number, vi

E
electrical requirements, 62
error messages, 65
errors

hardware, 62, 63
reporting, 68

F
fuse, 57, 62

H
hardware

components, 5
errors, 62, 63, 68

home position
Current Position value, 44
described, 9, 34
setting, 35

I
indicator lights, 7

J
job roles for readers of this guide, vi

K
knowledge base, viii

L
lab automation software, 10
Labware Editor, 26
Labware MiniHub

ActiveX control, 11
adding in device file, 16, 21
base, 5
cassettes, 6, 34
checking errors, 52
components, 5
connecting to, 32
described, 2
disabling and enabling motor, 46
fuses, replacing, 57
home position, 34
models, 2
power supply, 6
profile, 30, 31, 33, 42
properties, setting, 23
quick start, 12
rotating, 49
safety, 4
setting up in the VWorks software, 16
shelves, 5
spacers, 6
spare parts, 105
teachpoints, robot, 39

Labware MiniHub Diagnostics
Controls tab, 42, 74
described, 9, 42
Profiles tab, 32, 72

log area, 53
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M
models, Labware MiniHub, 2
motor, disabling and enabling, 46

O
on/off switch, 6
online help, viii

P
PDF guide, viii
plugins

loading, 21
storage location, 21

Position display, 34, 37, 44
power connection, 62
power supply, 6
power switch, 6
profiles

creating, 31, 42
defined, 30
described, 9, 30
editing, 33
initializing, 32
managing, 33
saving, 32
selecting, 24
updating, 38

Profiles tab, 32, 72
protocols, 10

R
Reload Plugins command, 21
rotating, 49

S
safety

operation, 4
serial port, 32
setup workflow, 16
shelves, 5

cleaning, 56
Slots Per Cassette parameter, 32
software

errors, 65, 68
reporting errors, 68
version number, vi, 68

spacers, 6
spare parts, 105
speed setting, 32
Stack holding method parameter, 26
system model, 2

T
Teach Home command, 37
teachpoints, robot, 39
troubleshooting, 9, 41, 42

hardware errors, 62, 63
software errors, 65

U
user guide

described, vi
related guides, vii

V
version numbers, software, vi, 68
VWorks software, 10, 16

W
Windows registry files, 30
workflows

configuring, 30
configuring in diagnostics, 30
quick start, 12
setup in the VWorks software, 16
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